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Inleiding 

Hartelijk dank voor het kiezen van de Noxturnal® toepassingssoftware. De Noxturnal software is een 

modern slaapdiagnostieksoftwareplatform bestemd voor het vergemakkelijken van de gebruiks- en 

de bedieningsefficiëntie. De belangrijkste functie ervan is het werken met registraties opgenomen 

met registratieapparatuur van Nox Medical (zie het hoofdstuk Ondersteunde registratieapparatuur) 

en neemt de gebruiker mee door de werkstroom van het configureren van registraties, het 

downloaden van data, analyseren en rapporteren.  

Beoogd gebruik 

De Noxturnal toepassing (software) is in interactie met Nox Sleep Recorders en het Nox C1 Access 

Point voor controledoeleinden. Nocturnal ondersteunt zowel ambulant als online slaaponderzoek. 

Nocturnal wordt gebruikt voor het beoordelen van ambulante onderzoeken alsmede het bekijken van 

signalen die in realtime installatie worden geregisteerd. Onlineinstallaties die worden ondersteund 

zijn A1 Recorder via Bluetooth ingangspunt of de A1-recorder met het Nox C1-toegangspunt. De 

toepassing maakt navigatie, analyse en archivering van deze signalen en onderzoeken mogelijk en kan 

automatische analyse uitvoeren en analyserapporten aanmaken.  

Noxturnal is bestemd voor patiënten ouder dan 2 jaar. 

De beoogde omgevingen zijn ziekenhuizen, instellingen, slaapcentra, slaapklinieken en andere 

testomgevingen. 

Contra-indicaties 

De Noxturna software is NIET bestemd voor patiëntmonitoring of automatische diagnose. 

Reikwijdte 

Deze handleiding betreft de Noxturnal software,behalve de Nox registratieapparatuur en 

bijbehorende accessoires die nodig zijn voor de registratie van fysiologische signalen. 

Waarschuwingen en voorzorgen voor gebruik  

 Waarschuwing: De Nox registratiesystemen zijn NIET GECERTIFICEERD VOOR GEBRUIK VOOR 

CONTINUE MONITORING waar storing letsel bij of overlijden van de patiënt kan veroorzaken. 

 Waarschuwing: De Nox registratiesystemen zijn alleen bestemd als aanvulling bij de 

patiëntbeoordeling. Ze moeten worden gebruikt in combinatie met andere methoden voor de 

beoordeling van klinische tekenen en symptomen. 

 Waarschuwing: Automatische analyses in Noxturnal, met name analyses voor de berekening van hart- en 

ademhalingsfrequentie uit onderliggende ecg- en ademhalingsinspanningssignalen, zijn niet gevalideerd 

voor patiënten met diafragma-pacing/frenische-zenuwstimulators. 

 Waarschuwing: De drukkolom in het hoofdstuk PAP-overzicht van het PAP-rapport en het PSG-

PAP-rapport vertegenwoordigt de maskerdruk van het overeenkomstige apparaat en NIET de 

ingestelde druk van het apparaat. 

 Opgelet: Volgens de Amerikaanse Federale wetgeving mag dit apparaat uitsluitend door of op 

voorschrift van een arts worden verkocht. 
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 Waarschuwing: De Nox-recorders mogen onder geen enkele omstandigheid worden 

aangesloten op de usb-poort terwijl de patiënt erop is aangesloten. Dit kan leiden tot een 

elektroshock bij de patiënt en tot ernstige schade. 

 

 Lees deze handleiding voorafgaand aan gebruik zeer goed door, met name 

secties gemarkeerd met een uitroepteken. 
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Softwarebeschrijving 

De Noxturnal software is ontworpen voor de Nox Slaaprecorders en het Nox C1 Toegangspunt. De 

software maakt de configuratie van de apparatuur mogelijk alsmede navigatie, analyse, rapportage en 

archivering van registraties uit de apparatuur. Dit hoofdstuk beschrijft de belangrijkste kenmerken 

van de toepassing en de installatieinstructies. 

Ondersteunde registratieapparatuur  

Noxturnal ondersteunt de volgende registratiepapparatuur en de bijbehorende apparatuur en 

accessoires. 

 Nox A1 PSG-recorder. 

 Nox T3 Slaaprecorder 

 Nox C1 Toegangspunt 

Installatie van Noxturnal 

Bestudeer voorafgaand aan de installatie van de Noxturnal software de systeemeisen voor het 

uitvoeren van de toepassing. 

Systeemeisen voor Noxturnal 

De volgende tabel toont de minimumhardware-eisen nodig voor de effectieve installatie en gebruik 

van de software. 

 

 De gebruikte computer moet in overeenstemming zijn met de internationale 

norm IEC 60950-1 voor de veiligheid van informatietechnologieapparatuur. 

 Het is aanbevolen om een virusbescherming te installeren op de computer 

waarop Noxturnal wordt uitgevoerd. 

Minimumsysteemeisen 

Type hardware Minimumeisen 

Besturingssysteem Windows® Vista 

Processor Op X86 gebaseerd Intel of AMD 

Processorkloksnelheid 1,7 GHz of sneller 

Geheugen 1 GB of meer 

Vrije ruimte op de harde schijf 500 MB of meer 

Grafische resolutie 1024x768 of hoger 

Voor online systeeminstallatie zijn dezelfde minimum systeemvereisten van toepassing als hierboven 

genoemd. Het wordt met klem aanbevolen om voor elk onlinesysteem een andere computer te 

gebruiken. Voor ervaren gebruikers is het echter mogelijk om meer dan één systeem uit te voeren op 

dezelfde computer en hieronder volgen de hardware-eisen voor een dergelijke installatie. 

Type hardware Minimumeisen 
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Processor Intel core i7 quad core of hoger OF AMD-compatible 

RAM  
Harde schijf  

16 GB of hoger 

512 GB of hoger 

Installatieinstructies 

 Zorg dat u met beheerderprivileges bent ingelogd in het systeem. 

 Zoek op de installatie-cd naar een bestand met de naam Setup.exe en voer dat uit. 

 Een wizard wordt geopend en die leidt de gebruiker door de installatie. Volg de instructies 

voor het installeren van de toepassing. 
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Standaardbediening 

Om de Noxturnal applicatie uit te voeren, dubbelklikt u op het desktopicoontje of klikt u op het 

icoontje van de toepassing in het Windows-startmenu. Om de toepassing af te sluiten, klikt u op de X 

in de rechterbovenhoek of kiest u Exit (Afsluiten) in het menu File (Bestand). 

Als Noxturnal opstart, wordt de werkruimteomgeving weergegeven. Als u een apparaat hebt 

aangesloten, ziet u dat in de afbeelding, anders wordt geen apparaat weergegeven. Voor het doel van 

dit document hebben we een Nox T3 recorder aangesloten, zoals in de afbeelding te zien is. 

 

Het venster Recording (Registreren) is het venster waarin de gebruiker werkt met Nox-apparaten en 

de geregistreerde data. Dit venster leidt de gebruiker door de meest algemene taken die in de 

toepassing kunnen worden uitgevoerd. Deze zijn: 

 Library (Bibliotheek): Deze optie ziet u in de linkerbovenhoek. Deze optie opent de 

registratiebibliotheek. De bibliotheek bevat een lijst van alle registraties die zijn gedownload 

of handmatig toegevoegd aan de registratiebibliotheek. Zie voor meer informatie het 

hoofdstuk De registratiebibliotheek. 

 Configureren van het apparaat: Selecteer deze optie om een nieuwe ambulante registratie 

te starten. Een configuratiewizard leidt de gebruiker door het configuratieproces. Zie voor 

meer informatie het hoofdstuk Starten van een nieuwe ambulante registratie.. 

 Downloaden van de registratie: Als een registratieapparaat is aangesloten die een registratie 

bevat, kan de gebruiker de registratie downloaden en bestuderen. Zie voor meer informatie 

het hoofdstuk Downloaden van een ambulante registratie van een Nox-registratieapparaat..  

Om een onlineregistratie te configureren, moet een onlinekamer worden voorgeconfigureerd en zal 

deze worden weergegeven op de Registratiepagina en selecteerbaar zijn. Voor instructie over het 
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configureren van een onlineregistratie, zie het hoofdstuk Installatie van het Nox A1-systeem voor 

onlineregistraties.. 

Aansluiting van een Nox registratieapparaat op Noxturnal  

Noxturnal wordt gebruikt voor het configureren en downloaden van geregistreerde data van Nox 

registratieapparaten. Om te werken met een registratieapparaat start u met het aansluiten daarvan 

op de computer, met een usb-kabel. Noxturnal detecteert automatisch het apparaat en geeft 

informatie weer over het apparaat. Detectie kan 2-4 seconden duren. 

Wanneer Noxturnal het aangesloten apparaat detecteert, wordt de volgende informatie over het 

apparaat weergegeven: recording status (registratiestatus), firmware version (firmwareversie) en 

device name (apparaatnaam).  

De op het registratieapparaat uitgevoerde taken zijn afhankelijk van de apparaatstatus, die als volgt 

kan zijn: 

 Empty (Leeg) - Het apparaat is niet geconfigureerd en bevat geen registraties. Klik op 

Configure Device (Apparaat configureren) om het apparaat te configureren voor een nieuwe 

registratie. NB Het configureren van het apparaat verwijdert bestaande registraties van het 

apparaat. 

 Ready to Record (Gereed voor registratie) - Het apparaat is geconfigureerd maar bevat geen 

registraties. Op dit punt kan de gebruiker het apparaat ontkoppelen en het registratieproces 

starten. 

 Ready to Download (Gereed voor downloaden) - Het apparaat bevat een registratie die niet 

is gedownload naar de computer. Klik op de knop Download Recording (Registratie 

downloaden) om de registratie te downloaden naar de computer.  

 Downloaden voltooid - Het apparaat bevat een registratie die al is gedownload en is 

toegevoegd aan de registratiebibliotheek. Op dit punt kan de gebruiker klikken op Configure 

Device (Apparaat configureren) om het apparaat te configureren voor een andere registratie 

of klikken op (Download Recording) Registratie downloaden om de registratie opnieuw te 

downloaden. 

Als u klaar bent met het werken met het apparaat klikt u op de koppeling Eject  en ontkoppelt u 

het apparaat van de computer. 

 

 NB. Hoewel wordt aanbevolen om het registratieapparaat via Eject te 

ontkoppelen kan het ook zonder Eject ontkoppeld worden van de computer 

Upgraden van de software van het registratieapparaat.  

Als een nieuwe versie van de apparaatsoftware beschikbaar is voor het aangesloten apparaat, 

informeert Noxturnal de gebruiker door een tip in een venster  weer te geven naast het apparaat. Dit 

gedrag is apparaatonafhankelijk en u ziet het type apparaat in dit venster, afhankelijk van welk 

apparaat u hebt aangesloten. In deze afbeelding hebben we een Nox T3 recorder aangesloten. 
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Kies ervoor om deze melding te negeren en door te gaan met werken of om de apparaatsoftware te 

upgraden. Dat laatste wordt altijd aanbevolen. Om te upgraden, klikt u op het venster en volgt u de 

instructies die worden gegeven op. 

 

 Na het klikken op het venster voor de upgrade moet u het registratieapparaat 

ontkoppelen van de computer en het weer aansluiten voor een 

softwareupgrade. 

 Het wordt altijd aanbevolen om de softwareupgrade uit te voeren, om er zeker 

van te zijn dat de Nox-recorder op de meest recente softwareversie draait. 

Nieuwe softwareversies kunnen belangrijke software-updates bevatten voor het 

functioneren van de recorder.  
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Starten van een nieuwe ambulante registratie.  

Om een registratieapparaat gereed te maken voor een nieuwe registratie start u de Noxturnal-

toepassing en sluit u het apparaat met een usb-kabel aan op de computer. Noxturnal detecteert 

automatisch het apparaat en geeft er informatie over op de pagina Recording (Registratie). Klik op 

Configure Device (Apparaat configureren) op de pagina Recording (Registratie). Dan opent een 

wizard die de gebruiker begeleidt bij het configuratieproces van het apparaat. 

De configuratiewizard is apparaatafhankelijk. Dit betekent dat de configuratiewizard varieert 

afhankelijk van het type Nox-recorder dat wordt geconfigureerd. De belangrijkste stappen zijn echter 

altijd hetzelfde: 

1.) Configuratie van het apparaat. Waar u het te gebruiken type registratie kiest 

(hulpapparatuur die kan worden aangesloten en te registreren kanalen) 

2.) Schedule Recording (Registratie plannen) waar u de tijd en datum kunt 

selecteren voor het opstarten van een registratie of waarop een patiënt de 

registratie zelf kan starten. 

3.) Patient Information (Patiënteninformatie), waar u de noodzakelijke 

patiënteninformatie voor de registratie toevoegt. 

Deze handleiding toont de configuratiewizard voor de Nox T3-recorder. De eerste stap is definiëren 

welk registratietype voor de registratie moet worden gebruikt. De registratietypen hebben 

beschijvende namen die de registraties aangeven waarvoor ze worden gebruikt. 

Zie de hoofdstukken Registratietypen en apparaatprofielen voor meer informatie over het aanmaken 

en bewerken van registratietypen en apparaatprofielen. 
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Als een registratietype wordt geïnstalleerd voor het registreren van data van een Bluetooth-apparaat, 

bijv. een pulsoximeter, zult u dat in de configuratiewizard zien. Om een Bluetooth-apparaat te kunnen 

gebruiken, moet dit contact maken met het registratieapparaat. Vul het juiste pin/BDA-nummer in in 

het daarvoor bestemde veld in de configuratiewizard.  

Klik op Next (Volgende) om verder te gaan naar stap twee, waar u de registratietijd plant. 

  

 Als de optie Manually Start Recording (Handmatig registratie starten) wordt aangevinkt, is 

de gebruiker verantwoordelijk voor het starten/stoppen van de registratie van het 

registratieapparaat. Dit wordt gedaan door de middelste knop ingedrukt te houden op het 

apparaat tot het scherm op het apparaat aangeeft dat de registratie is gestart. 

 Ga naar de optie Start Recording At: (Registratie starten om:) voor het plannen van een 

specifieke registratietijd. Het apparaat schakelt zichzelf in en begint op de aangegeven tijd 

automatisch met registreren. Als de gebruiker ervoor kiest om langer te registreren dan één 

nacht zal elke registratie bij elke nacht op dezelfde tijd beginnen. 

 Om na een specifieke duur te stoppen met registreren, specificeert u de Duration (Duur) als: 

7 uur, 8 uur, 10 uur of voert u een andere duur in. Als er voor Unspecified 

(Ongespecificeerd) wordt gekozen is de gebruiker verantwoordelijk voor het stoppen van de 

registratie. Dit wordt gedaan door de middelste knop ingedrukt te houden op het apparaat 

tot het scherm op het apparaat aangeeft dat de registratie is gestopt. 

Klik op Next (Volgende) om door te gaan naar de volgende stap, de patiënteninformatiedialoog. In 

deze dialoog is het mogelijk om uitgebreide informatie over de patiënt in te voeren. Het enige 

vereiste veld is de patiëntnaam of het patiënt-id.  
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Na de patiënteninformatie te hebben ingevoerd, klikt u op Finish (Afsluiten) om de configuratie weg 

te schrijven naar het apparaat. 

Nadat u op Finish (Afsluiten) hebt gedrukt, is het apparaat geconfigureerd. Als er een registratie op 

het apparaat staat, wordt de gebruiker gevraagd of hij/zij de registratie van de recorder wil wissen. 
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Ten slotte wordt een bevestigingspagina weergegeven ter bevestiging dat het apparaat is 

geconfigureerd. Voor sommige recorders (zoals de Nox T3) kunnen aansluitinstructies worden 

afgedrukt door te klikken op de knop Print Hookup Instructions (Aansluitinstructies afdrukken). Een 

pdf-document met het aansluitdiagram wordt gegenereerd en kan worden afgedrukt. Als er geen 

aansluitinstructies beschikbaar zijn, wordt deze optie niet weergegeven. 

  

Registratietypen 

Noxturnal biedt een reeks Recording Types (Registratietypen) die beschikbaar zijn voor configuratie 

van zowel ambulante als onlineregistraties. De registratietypen bevatten de apparaatcombinatie die 

wordt gebruikt voor verschillende typen onderzoeken en de apparaatinstellingen. De registratietypen 

definiëren ook de automatisering voor de verschillende registraties, de relevante werkruimtelayout, 

analyse en rapportage die voor de registratie worden gebruikt. In Noxturnal kunt u gemakkelijk uw 

eigen registratietypen aanmaken om apparaten en voor registraties gebruikte instellingen te regelen. 

Volg deze stappen om uw eigen registratietype aan te maken.  

1. Selecteer de Nox-recorder waarvoor u het registratietype aanmaakt en of dit is bestemd voor 

ambulante of onlineregistraties. 

2. Installeer het registratietype om de gewenste werkruimtelayout, analyse en rapportage en 

de apparaten en apparaatprofielen op te nemen 

De Registratietypewizard is apparaatafhankelijk. Dit betekent dat de wizard varieert afhankelijk van 

het type Nox-recorder dat wordt geconfigureerd. De belangrijkste stappen zijn echter altijd hetzelfde: 

1. Navigeer vanuit de Noxturnal taakbalk naar Devices > Recording Types (Apparaten > 

Registratietypen)…  
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De Registratietypewizard wordt geopend. 

 

Hier kunt u een Nieuw Registratietype, een New Based On (Nieuw op basis van) een van de 

beschikbare Registratietypen aanmaken en zelf gekozen registratietypen Edit (Bewerken) of Remove 

(Verwijderen). Voor dit voorbeeld zullen we een nieuw registratietype aanmaken voor het Nox T3-

apparaat.  
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1. Selecteer het Registratietype Nox T3 (ambulatory) (ambulant) uit de vervolgkeuzelijst zoals 

hieronder getoond. 

 

2. De volgende stap is het installeren van het registratietype zoals van toepassing. In de 

volgende wizard kunt u uw registratietype installeren.  
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3.  Typ 

de 

Recording Type Name (Registratietypenaam) en deDescription (Beschrijving) van het 

registratietype in. Kies de gewenste Workspace Layout (Werkruimtelayout), Analysis 

(Analyse) en Report (Rapportage). U kunt ook hulpapparaten toevoegen. Kies bijvoorbeeld 

de Nonin 3150 (onder Device Types (Apparatuurtypen)) en klik op Add (Toevoegen)>>. 
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NB Het is ook mogelijk om het toepasselijke apparaatprofiel voor dit registratietype rechtstreeks te 

kiezen in de registratietypewizard, zie hieronder. 

 

 

 

 

 

 

 

 

 

 

 

U kunt ook 

apparaatprofielen aanmaken, volg de instructies in het hoofdstuk Apparaatprofielen voor nadere 

instructies. Zodra u een apparaatprofiel hebt aangemaakt, wordt dit weergegeven in de 

vervolgkeuzelijst in de registratietypewizard. 

Als u uw registratietype hebt geïnstalleerd, klikt u op OK en komt uw zelfgekozen registratietype 

beschikbaar voor configuratie.  

Apparaatprofielen 

De apparaatprofielen worden aangemaakt voor alle standaardregistraties die u met Nox-recorders 

kunt uitvoeren. U kunt ze gebruiken om tijdens het apparaatconfiguratieproces eenvoudige 

installaties uit te voeren. 

Vanuit de Noxturnal taakbalk navigeert u naar Devices > Device Profiles… (Apparaten > 

Apparaatprofielen...) 

 

In de apparaatprofielenwizard kunt u een lijst zien van de beschikbare apparaatprofielen voor de Nox 

recorders en de Nox C1. 
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Om een eigen apparaatprofiel aan te maken, selecteert u New (Nieuw) of New Based On (Nieuw op 

basis van). U moet dan selecteren voor welk registratieapparaat de template is bestemd of op welk 

van de huidige apparaatprofielen u uw nieuwe template wilt baseren. Voor dit voorbeeld zullen we 

een nieuw apparaatprofiel aanmaken voor het Nox T3-apparaat. 
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In de profieleigenschappenwizard kunt u het apparaatprofiel installeren. Typ de naam in (en 

desgewenst een beschrijving).  

 

Klik op Next (Volgende) om verder te gaan naar de volgende stap. 

In de onderstaande dialoog kunt u de kanaalconfiguratie voor het apparaat installeren. De 

Configuratieapparaatdialoog is apparaatafhankelijk. Dit betekent dat de wizard varieert afhankelijk 

van het type Nox-apparaat dat wordt gebruikt. Als u de kanaalconfiguratie hebt geïnstalleerd, klikt u 

op Next (Volgende). 
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De laatste stap is het bepalen van het batterijtype dat wordt gebruikt voor uw registratieapparaat. 

Selecteer het van toepassing zijnde batterijtype en klik op Finish (Beëindigen). 

 

Het apparaatprofiel dat u zelf hebt aangemaakt wordt beschikbaar in de lijst met apparaatprofielen 

die beschikbaar zijn voor configuratie.  

 
 De apparaatprofielenwizards verschillen tussen de Nox-registratieapparaten. 

Downloaden van een ambulante registratie van een Nox-registratieapparaat.  

Om geregistreerde gegevens te downloaden van een registratieapparaat naar de computer, moet u 

zich ervan verzekeren dat Noxturnal draait en dan een apparaat aansluiten op een usb-poort op de 

computer. 

Noxturnal detecteert automatisch het apparaat en geeft er informatie over op de Recording Page 

(Registratiepagina). Detectie kan 2-4 seconden duren. 

Klik op de knop Download Recording (Registratie downloaden) en Noxturnal begint met het 

downloaden van de registratie vanaf het apparaat naar de computer. Een downloadprocesdialoog 

wordt weergegeven. Deze toont de downloadstappen tijdens het downloaden. De gegevens worden 

eerst gedownload, dan wordt het standaardanalyseprotocol uitgevoerd en, als het apparaat is 

geconfigureerd voor het registreren van audio, start de audiodownload. Het is mogelijk om met het 

werken met de data te beginnen op elk moment tijdens het downloaden van de data door te klikken 

op de link Start Working (Beginnen met werken). 
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Na het downloaden wordt de gebruiker op de hoogte gesteld en kan deze beginnen te werken met de 

gehele registratie. 

Het downloaden van registraties vindt altijd plaats naar de standaard gegevensopslaglocatie. Het is 

mogelijk om de standaard gegevensopslaglocatie te wijzigen op de automatiseringstab in de dialoog 

tools options (beschikbare tools) (Tools → Settings… → General, Tools → Instellingen… → 

Algemeen). Na het downloaden worden registraties automatisch toegevoegd aan de 

registratiebibliotheek en kunnen ze op elk moment worden bestudeerd door naar de 

registratiebibliotheek te gaan en deze te openen. Zie voor meer informatie het hoofdstuk De 

registratiebibliotheek.  

 

 Als het downloaden om de een of andere reden deels mislukt, kan dat leiden tot 

onduidelijke registratieresultaten. De gebruiker zal worden gewaarschuwd als 

dit gebeurt en moet dan beslissen of de geregistreerde gegevens al dan niet 

volledig zijn. Het is mogelijk om de gegevens nogmaals te downloaden vanaf het 

apparaat. 

 De gedownloade registratie wordt pas van het apparaat verwijderd als het 

apparaat wordt geconfigureerd voor een andere registratie. 
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Installatie van het Nox A1-systeem voor onlineregistraties.  

Netwerkoverzicht onlinesysteem 

Om gelijkmatige werking van de onlinefunctionaliteit van het Nox A1-systeem te verzekeren, volgt u 

de onderstaande aanbevolen systeeminstallatie.  

 Het wordt aanbevolen om voor elk onlinesysteem een andere computer te gebruiken. Het is 

echter mogelijk om meer dan één systeem uit te voeren op dezelfde computer. Zie het 

hoofdstuk Minimumsysteemeisen voor meer informatie.  

 Gebruik een apart local area network (LAN) voor elk Bluetooth-toegangspunt (Nox C1-

toegangspunt of BlueGiga) en een computer waarop de Noxturnal software draait. 

 Gebruik een apart Bluetooth-toegangspunt voor elke te gebruiken Nox A1-recorder. 

De onderstaande tabel beschrijft de installatie van de controlekamer waar de computer met 

Nocturnal geïnstalleerd is. 

Controlekamer 

Item Aansluiting 

PC 
Met een netwerkkabel aangesloten op 

hetzelfde netwerk als de Nox C1. 

Noxturnal Geïnstalleerd op een PC 

De onderstaande tabel beschrijft de installatie van een patiëntkamer waar de patiënt slaapt tijdens 

een slaaponderzoek. 

Patiëntkamer 

Itemnaam Beschrijving Functie Installatie/Aansluiting 

Nox C1-
toegangspunt 

Bluetooth-toegangspunt 
met analoge en seriële 
uitgangen en 
ingebouwde lichtsensor 
en differentiële 
druksensor. 

Communiceert met de 
Nox A1 met 
gebruikmaking van 
Bluetooth via ethernet: 
 Gegevensoverdracht 

van Nox A1 naar 
Noxturnal 

 Commado's van 
Noxturnal naar Nox 
A1 

 Gegevensoverdracht 
van via serieel of 
analoog kanaal 
aangesloten 
hulpapparaten 

Die zich bevinden in 
de patiëntkamer. 
Aangesloten op 
hetzelfde LAN als de 
pc waarop de 
Nocturnal-software 
draait. 

Bluegiga Bluetooth-toegangspunt 

Communiceert met de 
Nox A1 met 
gebruikmaking van 
Bluetooth via ethernet: 
 Gegevensoverdracht 

van Nox A1 naar 
Noxturnal 

Die zich in de 
patiëntkamer 
bevinden. 
Aangesloten op 
hetzelfde LAN als de 
pc waarop de 
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 Commando's van 
Noxturnal naar Nox 
A1 

Nocturnal-software 
draait. 

Nox A1-recorder 
en de van 
toepassing zijnde 
sensoren 

PSG-slaaprecorder 

Registreert fysiologische 
signalen vanuit 
bevestigde/aangesloten 
sensoren 

Aangesloten op de 
patiënt in de 
patiëntkamer. 

Medische 
hulpapparaten 

Elk medisch apparaat 
dat voldoet aan de 
invoerkanaalspecificaties 
van het Nox C1-apparaat 
of kan worden 
aangesloten op A1 via 
Bluetooth. 

Hangt af van het 
gebruikte hulpapparaat 

De van toepassing 
zijnde aansluitkabel 
aangesloten op de 
analoge/seriële/usb-
ingang op het Nox C1-
apparaat of via 
Bluetooth 

Onderstaande afbeelding toont een overzicht van de installatie van het Nox A1-onlinesysteem.

 

De Bluetoothtoegangspunten (Nox C1-toegangspunt of BlueGiga) worden aangestuurd door de 

Noxturnal-software.  

Voor verdere instructies over het Nox C1-toegangspunt en het Nox A1-apparaat, zie de Nox C1 

handleiding en de Nox A1 handleiding. 
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Onlinesysteemconfiguratie  

De Nox A1-recorder ondersteunt onlineregistratie van signalen. Om deze typen registraties uit te 

voeren, hebt u een Noxturnal A1 Online Acquisition License nodig op uw computer en een Bluetooth-

toegangspunt (Nox C1-toegangspunt of BlueGiga). Raadpleeg voor nadere informatie hierover Nox 

Medical of hun vertegenwoordigers. Dit hoofdstuk beschrijft hoe het Nox A1-onlinesysteem moet 

worden opgezet en hoe in Noxturnal onlineonderzoeken moeten worden uitgevoerd.  

Overtuig u er eerst van dat u alle nodige accessoires hebt geïnstalleerd, zoals het Nox C1-

toegangspunt, ethernetkabels en dergelijke. Zie voor meer informatie over de installatie van uw 

netwerk, waaronder het Nox C1-toegangspunt, de Handleiding van de Nox C1.  

Om het systeem op te zetten in Noxturnal moet u de volgende stappen uitvoeren zoals van 

toepassing: 

1. Installatie onlinekamers 

2. Configuratie nieuwe sensoren 

3. Installatie apparaatprofielen 

4. Installatie registratietypen 

Deze stappen worden hieronder genoemd. Door deze stappen te volgen, kunt u beginnen met uw 

onlineregistratie en dan beginnen te werken met de signalen in Noxturnal. 

Onlinekamer 

Het installeren van een Onlinekamer is onderdeel van de installatie van Noxturnal voor 

onlineregistraties. De Onlinekamer betreft verzameling van benodigdheden die u normaal gesproken 

in een kamer bij elkaar houdt. Dit kunnen bijvoorbeeld alle apparaten zijn die u in een 

ziekenhuiskamer bij de hand hebt en die speciaal zijn bestemd voor slaaponderzoeken.  

Om een nieuwe kamer toe te voegen, selecteert u Devices > Online Rooms… (Apparaten > 

Onlinekamers…) uit de Noxturnal taakbalk. U krijgt dan de Rooms (Kamers) dialoog in beeld. 
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Van hieruit kunt u een nieuwe kamer toevoegen of een bestaande bewerken. Om een nieuwe kamer 

toe te voegen, klikt u op Add Room (Kamer toevoegen) en in onderstaande dialoog kunt u de nieuwe 

kamer een naam geven door te klikken op het potloodpictogram en apparaten toe te voegen aan uw 

kamer door te klikken op Add Devices (Apparaten toevoegen). 
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In de Add Devices (Apparaten toevoegen) wizard kunt u apparaten aan uw kamer toevoegen. Om 

een apparaat toe te voegen, selecteert u het van toepassing zijnde apparaat uit de lijst Device Types 

(Apparaattypen) en klikt u op Add>> (Toevoegen>>) of dubbelklikt u op het apparaat uit de lijst. U 

kunt scannen op aangesloten IP-apparaten op uw netwerk door te klikken op Scan for IP Devices 

(Scan op IP-apparaten). 

 

Als u een Nox A1-recorder toevoegt, moet u het van toepassing zijnde toegangspunt selecteren dat in 

de kamer wordt gebruikt en klikken op Scan voor uw Nox A1-recorder of handmatig het serienummer 

van de A1 intypen. Vergeet niet om voor deze stap uw recorder in te schakelen. Selecteer uw recorder 

uit de lijst en klik Next (Volgende).  
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Als u een selectie van apparaten hebt toegevoegd aan de verzameling van beschikbare apparaten, 

kunt u de apparaten selecteren die u wilt toevoegen aan uw Onlinekamer.  

 

Om apparaten te selecteren om toe te voegen aan uw kamer, klikt u op het apparaat en er verschijnt 

een blauw kader rond elk geselecteerd apparaat. Als u de apparaten hebt geselecteerd voor 

toevoeging aan de kamer, klikt u op Add to Room (Aan kamer toevoegen) en wordt uw kamer met 

deze selectie van apparaten toegevoegd. 
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U hebt nu de configuratie van de onlinekamer voltooid. U doet hetzelfde als wat hierboven is 

beschreven als u nog meer kamers wilt toevoegen.  

Configuratie van nieuwe sensoren 

Als u nieuwe sensorconfiguraties wilt toevoegen, bijvoorbeeld voor gebruik met de Nox C1, kunt u dat 

doen door te navigeren naar Devices > Sensors… (Devices > Sensoren…) vanuit de Noxturnal 

taakbalk. 

   

Vanuit de Manage Sensors (Sensoren beheren) wizard kunt u een nieuwe sensor aanmaken en 

bestaande sensoren bewerken/verwijderen. Om een nieuwe patiëntsensor of hulpsensor aan te 

maken, klikt u op New (Nieuw).  
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U kunt selecteren of een nieuwe patiëntsensor of een hulpsensor moet worden aangemaakt. Vul de 

van toepassing zijnde velden in en klik op OK om de sensorconfiguratie op te slaan. 

Apparaatprofielen voor onlineapparaten 

Voor de Nox-apparaten die gebruikt zijn voor onlineregistraties (Nox A1 (online) en Nox C1) kunt u 

Device Profiles (Apparaatprofielen) installeren. De apparaatprofielen bevatten de kanaalconfiguratie 

van het apparaat. Noxturnal biedt een scala van standaard apparaatprofielen en u kunt ook 

gemakkelijk nieuwe apparaatprofielen installeren. Voor instructies over hoe u apparaatprofielen aan 

uw wensen kunt aanpassen, zie het hoofdstuk Apparaatprofielen. 

Registratietypen voor onlineapparaten 

De laatste stap is het installeren van registratietypen. Dit is een lijst van de typen registraties die u 

online zult registreren in uw kliniek. Elk registratietype brengt een verzameling bij elkaar van 

beschikbare onlineapparaattypen die samen worden gegroepeerd. Voorbeelden zijn: Standaard PSG 

met Nox C1, brengt bij elkaar een Nox C1-toegangspunt, Nox A1-recorder, Nonin 3150-oximeter en 

een videocamera. Voor instructies over de installatie van nieuwe Registratietypen zie het hoofdstuk 

Registratietypen. 

Starten van een onlineregistratie 

Als u de bovenstaande stappen hebt voltooid voor het installeren van uw onlineconfiguratie, kan een 

onlineregistratie worden gestart. Vanuit de registratiepagina kunt u een onlineregistratie starten 

binnen de kamer die u hebt geïnstalleerd. Om de registratie te starten, dubbelklikt u op het 

kamerpictogram of klikt u op Configure Recording (Registratie configureren). 
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Dan wordt de Start Online Recording (Onlineregistratie starten) wizard weergegeven. Met deze 

wizard kunt u: 

 het Registratietype dat zal worden uitgevoerd selecteren uit de vervolgkeuzelijst. 

 De selectie van Apparaten is afhankelijk van het geselecteerdeRegistratietype. Alle 

apparaten die beschikbaar zijn in de onlinekamer worden genoemd, maar de apparaten 

die geen deel uitmaken van het registratietype zijn grijs gemaakt. U kunt de 

uitgeschakelde apparaten in de registratie opnemen door het aanvinken van de 

desbetreffende hokjes in de lijst van apparaten. 

 Selecteer Device Profile (Apparaatprofiel) voor een aantal apparaten, zoals de Nox A1 

en de Nox C1. 
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Als u uw Registratietype en de juiste apparaten hebt geselecteerd samen met hun 

Apparaatprofielen, kunt u op Next (Volgende) klikken om naar de patiëntinformatie te gaan. De 

laatste stap is het starten van de registratie en dat doet u door te klikken op Start Recording 

(Registratie starten) binnen de Patiëntinformatiewizard.  

U ziet dan uw geselecteerde werkruimtelayout, waarbij een statusvenster de status toont van de 

registratie die aan het starten is. Ten slotte ziet u in realtime de geregistreerde signalen verschijnen 

en kunt u ermee beginnen te werken. 

Nox C1-configuratie 

Het Nox C1-apparaat is voorzien van 12 analoge kanalen die geschikt zijn voor het opvangen van DC-

signalen van hulpapparaten. De kanalen worden opgevangen op 6 poorten, gelabeld DC IN, van 1 tot 

en met 12, bovenop het apparaat. Elke analoge poort is geschikt voor 2 kanalen. Hulpapparaten 

kunnen worden aangesloten op de analoge ingangen van de Nox C1. Het voltagebereik maakt 

communicatiesignalen mogelijk van -5 V tot +5 V. Zie voor nadere informatie over het Nox C1-

apparaat de handleiding van de Nox C1.  

Nox C1-netwerkconfiguratie 

De standaard fabrieksconfiguratie van de Nox C1 wordt weergegeven in de onderstaande tabel. De 

Nox C1-netwerkconfiguratie kan worden beheerd door middel van Noxturnal. 
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Nox C1-netwerkconfiguratie Gegevens 

DHCP-server DHCP-pool: 192.168.101.64 - 192.168.135.128 

Statisch IP-adres 192.168.101.10 

Universele Plug and Play (UPnP) 

ontdekking 

Netwerkprotocol dat mogelijk maakt dat de Nox C1 op een 

netwerk wordt ontdekt  

Om de netwerkconfiguratie van de Nox C1 te beheren, kunt u een Onlinekamer openen die is 

geconfigureerd (Devices > Online Rooms…, Apparaten > Onlinekamers) en de Nox C1 selecteren 

binnen de kamer en dan op Edit Device (Apparaat bewerken) klikken. In de onderstaande dialoog 

kunt u zien hoe u de netwerkconfiguratie van de Nox C1 kunt wijzigen.  

 

Integratie van videoapparaten voor onlineregistraties  

Noxturnal ondersteunt onlinevideoregistratie. Om de door Noxturnal geboden digitale video-

ondersteuning te gebruiken bij een onlineregistratie moet u uw onlinesysteem zodanig configureren 

dat er een videosysteem deel van uitmaakt. 

Een videoapparaat kan aan uw onlinesysteem worden toegevoegd en de installatie kan voor 

toekomstig gebruik worden opgeslagen. Om een videoapparaat te configureren met uw 

onlinesysteem, moet u: 

1. Zorgen dat er video codecs op uw computer is geïnstalleerd. 



 

   

~ 35 ~ 

2. Zorgen dat het videoapparaat is aangesloten op hetzelfde netwerk als het Nox C1-

toegangspunt/BlueGiga en de computer waarop Noxturnal draait  

3. Installatie van een Online Room (Onlinekamer) inclusief het videoapparaat 

4. Installatie van een Registratietype inclusief het videoapparaat en definitie van het 

videoprofiel  

5. Selecteren van de Onlinekamer en starten van een onlineregistratie vanuit de Noxturnal 

Registratiepagina 

Installatie van een Onlinekamer met een videoapparaat 

VIDEO CODECS 

Noxturnal’s ondersteuning voor video is gebaseerd op de video codecs die is geïnstalleerd op uw 

computersysteem. Deze video codecs is gespecialiseerde software die de compressie en 

decompressie van digitale video mogelijk maakt. Noxturnal installeert geen codecs, maar op de 

meeste computersystemen is een type codecs geïnstalleerd. U moet codecs op uw systeem 

geïnstalleerd hebben om video met Noxturnal te kunnen gebruiken. Noxturnal geeft u dan toegang 

tot de functies die door deze codecs worden ondersteunt. U kunt het K-Lite Codec Pack downloaden 

van de ondersteuningssite van Nox: http://support.noxmedical.com/hc/en-us/articles/207882176  

VIDEOCAMERA-INTEGRATIE 

Voor het installeren van een onlineregistratie inclusief een videoapparaat volgt u de onderstaande 

stappen. 

1. Installatie van een Onlinekamer in Noxturnal, zoals uitgelegd in het hoofdstuk Onlinekamer 

(Devices > Online Rooms…, Apparaten > Onlinekamers...) op de Noxturnal taakbalk.  

 

2. Voeg een videoapparaat toe aan uw Onlinekamer door te klikken op Add Devices 

(Apparaten toevoegen) en Video Device (Videoapparaat) te kiezen uit de lijst Device Types 

(Apparaattypen).  

http://support.noxmedical.com/hc/en-us/articles/207882176
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3. U ziet de 

apparaateigenschappendialoog hieronder weergegeven. Klik op de toepasselijke optie, 

afhankeljk van het gebruikte videoapparaat en klik op Next (Volgende). 

 

Om uw IP-camera te installeren, klikt u op Find… (Vinden...) en Noxturnal scant uw netwerk en ontdekt 

videocamera's die zijn aangesloten op uw netwerk, mits UPnP (netwerkprotocol waarmee een IP-

camera kan worden ontdekt op een netwerk) erop is ingeschakeld. Noxturnal biedt standaard 
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aansluitingsopties voor sommige IP-camera's (Axis- en D-Link-camera's). Zorg ervoor dat bij het kiezen 

van de aansluitingsstring die beschikbaar is in Noxturnal de aansluitingsstring (URL) wordt gekozen in 

overeenstemming met de registratie die u uitvoert, als er alleen maar de video moet worden 

geregistreerd of beide, zowel de video als audio moet worden geregistreerd.  

Als uw camera niet automatisch door Noxturnal wordt ontdekt bij gebruik van de actie Find… 

(Vinden...) kunt u altijd uw camera handmatig toevoegen door de relevante aansluitingsstring (URL) en 

het IP-adres van de camera-IP in te voeren in het veld File or URL (Bestand of URL).   

 

Als u een videoapparaat hebt dat van een ander type is dan Axis of D-Link, kunt u altijd nieuwe 

aansluitingsstrings (URL) toevoegen waar u in de toekomst toegang toe hebt bij gebruik van 

Noxturnal. Om dat te doen, bladert u naar Tools > Settings > Advanced (Tools > Instellingen > 

Geavanceerd en selecteert u de Default Settings (Standaardinstellingen). Open de map Video 

Profiles (Videoprofielen) en open het Excel-werkblad IPCameras. U kunt aan de bestaande lijst van 

aansluitingsstrings een nieuwe aansluitingsstring toevoegen voor uw videoapparaat en die 

beschikbaar zal zijn voor gebruik binnen Noxturnal.  

Als u de gebruikers- en wachtwoordinformatie voor uw camera hebt ingevoerd, kunt u klikken op 

Start Preview (Preview starten) om te bekijken of uw camera correct is geïnstalleerd en werkt met 

Noxturnal. Als een vertraging wordt waargenomen tijdens de preview, kan een vertragingsinput 

worden toegevoegd om het opnieuw afspelen van de video tijdens de analyse te corrigeren. Klik op 

Next (Volgende) en u kunt de camera een unieke naam geven; klik daarna op Finish (Beëindigen).  
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U hebt nu het videoapparaat toegevoegd aan uw onlinekamer.  

Installatie van een registratietype met een videoapparaat  

Noxturnal voorziet in standaard registratietypen voor onlineregistraties inclusief een videoapparaat. U 

kunt een van de standaard registratietypen selecteren en direct starten met een onlineregistratie 

inclusief een videoapparaat. U kunt ook een registratietype naar eigen keuze installeren en het 

Windows Mediaprofiel definiëren voor gebruik met Noxturnal bij registratie en compressie van de 

onlinevideo. Om dat te doen, navigeert u naar Devices > Recording Types... (Apparaten > 

Registratietypes…) uit de Noxturnal taakbalk. In de Registratietypen wizard selecteert u New (Nieuw) 

en Online (Online). 
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In de wizard registratietype online kunt u zowel uw videoapparaat als andere apparaten toevoegen. U 

kunt het videoprofiel dat u wilt gebruiken selecteren uit de vervolgkeuzelijst, zie afbeelding hieronder.  
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Noxturnal voorziet in selectie van standaard videoprofielen, maar u kunt eigen profielen aanmaken en 

gebruiken in Noxturnal. Voor verdere informatie en instructies over hoe u dat moet doen, zie de Nox 

ondersteuningssite, Windows Media Profiles in Noxturnal. 

U hebt nu uw onlinesysteem zo geconfigureerd dat een videoapparaat er deel van uitmaakt en u kunt 

een onlineregistratie starten vanuit de pagina Recording (Registratie) door te dubbelklikken op de 

kamer, of u klikt op Configure Recording (Registratie configureren).  
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Uitvoeren van Noxturnal 

Dit hoofdstuk beschrijft hoe u de registraties in Noxturnal uitvoert en ermee werkt. 

Registratieresultatenpagina  

Na het downloaden vanaf een registratieapparaat of het openen van een bestaande registratie in 

Noxturnal, wordt de pagina Recording Results (Registratieresultaten) weergegeven. Deze pagina 

bevat een overzicht van de meest algemene analyseparameters en de geregistreerde signalen. De 

resultaatpagina wordt automatisch geüpdatet wanneer veranderingen worden doorgevoerd in de 

bestaande scoretoekenning of als de automatische analyse wordt uitgevoerd. Wanneer slaapstadia 

beschikbaar zijn, zoals voor registraties uitgevoerd met het Nox A1-apparaat, dan ziet u grafieken en 

informatie bij die informatie. Voor het Nox T3-apparaat ziet u alleen parameters die beschikbaar zijn 

met dat apparaat. 

 

Resultaatpaginaopdrachten 

De resultatenpagina heeft knoppen voor de volgende acties: 

 Close Recording (Registratie sluiten): Deze optie sluit de actieve registratie en gaat terug 

naar de Registratiebibliotheek hetzij de Registratiepagina. 

 View Signals (Signalen bekijken): Deze optie selecteert het eerste beschikbare signaalblad, 

waardoor u kunt bladeren door de geregistreerde signalen, automatisch gescoorde 

voorvallen kunt bekijken en handmatig gescoorde voorvallen kunt bewerken. 

 View Report (Rapport Bekijken): Deze optie maakt het standaard rapport voor de registratie, 

het rapport gedefinieerd binnen het Registratietype (zie voor verdere informatie het 

hoofdstuk Registratietypen). 

 Print Report/Result Page (Afdrukken rapport/Resultaatpagina): Deze optie drukt het 

standaard rapport en/of de registratieresultatenpagina af. 
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 Recording Status (Registratiestatus): Deze optie maakt het instellen van de status van 

registraties mogelijk. Gedownloade registraties hebben altijd de status New (Nieuw). Als een 

registratie om de een of andere reden is mislukt, kan de status worden ingesteld op Invalid 

(Ongeldig). Als de registratie is gediagnosticeerd, kan de status worden ingesteld op Scored 

(Gescoord). Als de registratie en de scoretoekenning zijn bestudeerd, kan de status worden 

ingesteld op Reviewed (Bestudeerd). Als de registratie is geïnterpreteerd, kan de status 

worden ingesteld op Interpreted (Geïnterpreteerd). Als een registratie is gediagnosticeerd 

en geaccepteerd, kan de status worden ingesteld op Done (Gereed). 

 Play Audio (Audio afspelen): Als de registratie audio bevat kan de knop play audio (audio 

afspelen) worden gebruikt voor het afspelen van de audio. Audio playback (Terugspelen 

audio) kan ook worden afgespeeld of gepauzeerd door de spatiebalktoets in te drukken. 

Patiëntinformatie 

Het Information (Informatie)-panel toont informatie over de geregistreerde patiënt. Bewerk de 
registratie-eigenschappen en de patiëntinformatie door de link Edit (Bewerken) te selecteren of door 
te drukken op de shortcuttoets Ctrl+I. 

 
 

Slaapparameters 

Het panel Sleep Parameters (Slaapparameters) toont de belangrijkste analyseparameters en hun 

relatie tot de ernst. De AHI, de Apnea Hypopnea Index, is het aantal apneus en hypopneus per uur 

slaap en de ODI is het aantal gescoorde zuurstofsaturatiedalingen per uur slaap (standaard 

automatische analysescores alle desaturaties van 3% of hoger maar dit kan door de gebruiker worden 

ingesteld). De ernst gaat van Normaal → Mild → Matig → Ernstig en is in overeenstemming met de 

door de AASM vastgestelde niveaus. Als meer dan één nacht is geregistreerd, tonen deze parameters 

de gemiddelde waarden voor alle nachten. Zie het hoofdstuk Analyseprotocols voor meer informatie. 
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Signaaloverzicht en parameters 

Het panel Signal Overview (Signaaloverzicht) is een top-down bestuderingstool waarmee 

registratieresultaten op een efficiënte manier kunnen worden bestudeerd en bewerkt. Het 

overzichtpanel wordt opgesplitst in analyseparameters rechts en signaaloverzicht links. 

 

De analyseparameters tonen een overzicht van de meest algemene analyseparameters, zoals 

Hypnogram of Totale slaaptijd, AHI, etc., voor één nacht. Als meer dan één nacht is geregistreerd, 

dan wordt elke nacht gerepresenteerd binnen zijn eigen panel. U kunt ook de te bekijken periode 

selecteren met het periodemenu in de rechterbenedenhoek van de toepassing. Elke parameter is van 

een kleurcode voorzien op basis van zijn ernst, variërend van groen tot rood (Normaal → Mild → 

Matig → Ernstig). 

 Arousal Index is het aantal arousals per uur tijdens de slaap. 

 Sleep Onset Latency is de duur in minuten (Analysiestarttijd) tot de eerste periode van 

gescoorde slaap 

 REM Onset Latency is de duur in minuten van het eerste optreden van slaap tot het eerste 

optreden van REM. 

 De slaapefficiëntie varieert van 0-100%, waarbij 0% betekent dat de patiënt de gehele nacht 

wakker was en 100% betekent dat hij gedurende de gehele nacht heeft geslapen. Als slaap 

scoren niet beschikbaar is gebruikt de software bewegingsperioden om deze parameter te 

schatten. 

 Total Sleep Time (Totale slaaptijd) is de tijd die de patiënt slapend heeft doorgebracht. 

 Wanneer Total Sleep Time (Totale slaaptijd) niet beschikbaar is, is de Est. Total Sleep Time 

(Geschatte totale slaaptijd) de gebruikte parameter. Dat is de tijd die de patiënt liggend 

doorbrengt tijdens de registratie. De groene kleurcode (normaal) wordt weergegeven als de 

patiënt langer dan 6 uur ligt. 

 De ademhaling wordt weergegeven door indices. Indices zijn een methode om 

analyseparameters voor te stellen op een gestandaardiseerde manier. 

o Apnea Hypopnea Index (AHI) 

o Apnea Index (AI) 
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o Hypopnea Index (HI) 

o De Oxygen Desaturation Index (ODI) stelt een aantal zuurstofdesaturatievoorvallen 

per uur voor van de Total Sleep Time (Totale slaaptijd) of ander de Est. Total Sleep 

Time (Geschatte totale slaaptijd). 

o Het Snore Percentage (Snurkpercentage) is de proportie slaaptijd doorgebracht in 

snurkepisodes (gemarkeerd als Snore-trains) 

o Average dB (Gemiddelde dB) zijn de gemiddelde dB-niveaus tijdens snore-

trainperioden. 

 De totale Signal Quality (Signaalkwaliteit) wordt bepaald uit de monitoring van de 

signaalkwaliteit van de volgende signalen: oximeter, luchtstroom, buik- of thoracale 

ademhalingsinspanningssignalen. De laagste signaalkwaliteit van die signalen wordt 

weergegeven voor de totale Signal Quality (Signaalkwaliteit) op de 

Registratieresultatenpagina en heeft een waarde van 0-100%. 

Signalen en voorvallen 

De signalen en voorvallen geplot in het signaaloverzichtpanel geven een overzicht van de gehele 

nacht. 

 Tot de signalen in het overzicht kunnen de volgende behoren: 

o Spectrogram voor het op het scherm weergegeven kanaal 

o Arousals/Hypnogram toont de arousals en slaapstadia gedurende de gehele nacht 

o Slaaptijd 

o Beweging 

o Positie 

o Apneus/RIP-fase (fase tussen buik- en thoracale ademhalingsinspanningssignalen) 

o Zuurstofdesaturatie (SpO2) 

o Pols 

o Audiovolume (Snurk-dB)  

o Beenbewegingen (optioneel) 

 De in het overzicht getoonde voorvallen zijn apneus en hypopneus, 

zuurstofsaturatiedalingen, snurkepisodes en artifacten. 

Als u de muiscursor verplaatst over de pictogrammen Arousals/Hypnogram 

(Arousals/Hypnogram), Sleep time/Movement/Position (Slaaptijd/Beweging/Positie), 

Apneas/RIP Phase (Apneus/RIP-fase) en O2 Desaturation (O2-desaturatie) en Pulse (Pols) krijgt u 

meer gegevens voor het bijbehorende signaal of de bijbehorende voorvallen. 
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Veranderen van de analyseperioden 

Als een registratie start voordat alle sensoren zijn bevestigd of als de patiënt de sensoren verwijdert 

voordat de registratie is geëindigd, is het mogelijk om het interval dat wordt geanalyseerd aan te 

passen door het verplaatsen van de analysestart-  en de analysestopmarker  naar de juiste plaats 

binnen de registratie. Alle analyseparameters worden dienovereenkomstig geupdatet wanneer deze 

aanpassingen worden gedaan. 

 

Gebruik om in de registratie te navigeren de synchronisatiemarker . Alle signaalbladen zoals de 

bladen PSG (PSG), Respiratory (Ademhaling) en Pulse Oximeter (Pulsoximeter) worden 

dienovereenkomstig gesynchroniseerd. Als een interessant voorval te zien is in het overzicht, sleept u 

de synchronisatiemarker over dat gebied en bladert u in het desbetreffende signaalblad om de ruwe 

signalen te bekijken.  

Voorvalperioden kunnen direct uit het panel Signal Overview (Signaaloverzicht) worden toegevoegd. 

Om een voorvalperiode toe te voegen, verplaatst u de muiscursor naar het panel Periods (Perioden) 

en klikt u met de muis. Het menu Event period (Voorvalperiode) zal verschijnen zoals hieronder 

getoond.  

 

Slaap scoren en uitsluiting van ongeldige gegevens kunnen worden uitgevoerd in het panel Signal 

Overview (Signaaloverzicht). Om slaap te scoren en ongeldige gegevens uit te sluiten van de 

registratie, verplaatst u de muiscursor naar het panel Periods (Perioden)-panel, klikt u op de 
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linkermuisknop en selecteert u een gebied door links/rechts te slepen. Laat de muisknop los. Het 

onderstaande menu is dan te zien. De voorvallen ‘Awake’ ('Wakker') en ‘Invalid Data’ ('Ongeldige 

gegevens') worden uitgesloten van de rapportberekeningen. 

 

Instellen van eenheden 

Om het eenhedensysteem te wijzigen dat wordt gebruikt voor het voorstellen van eenheden zoals 
lengte en gewicht, navigeert u naar Tools > Settings… (Tools > Instellingen…) uit de Noxturnal 
taakbalk. Op de pagina General (Algemeen) zoekt u de vervolgkeuzelijst  System Units 
(Systeemeenheden) en selecteert u het te bewerken toepasselijke veld. 
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Bekijken van signalen 

Werkruimtemenuknop 

Met de Workspace Menu Button ((Werkruimtemenuknop) kunt u verschillende werkruimtelayouts 

en signaalbladen aanmaken om de manier waarop u uw registraties wilt zien te beheren. De 

werkruimtelayouts bestaan uit selectie van signaalbladen en signaalbladeigenschappen. Noxturnal 

voorziet in een reeks standaard werkruimtelayouts (ademhalings- en PSG-layouts) en signaalbladen. U 

kunt ook werkruimtelayouts en signaalbladen naar uw eigen keuze installeren. U kunt alle wijzigingen 

in uw werkruimtelayout opslaan voor toekomstig gebruik. Dit betekent dat u instellingen kunt 

wijzigen en uw werkomgeving kunt inrichten zoals u dat wilt. 

 

U kunt de menuknop Workspace (Werkruimte) gebruiken voor de bewerking Add Sheet (Blad 

toevoegen), een New Workspace Layout (Nieuwe werkruimtelayout) aanmaken, een standaard  

layout als basis gebruiken of zelfs na het doorvoeren van wijzigingen Revert Layout (Layout 

terugzetten). 

 

Om een eigen signaalblad op te slaan, klikt u met de rechtermuisknop op de signaalbladtab en 

selecteert u Save Sheet Layout As... (Bladlayout opslaan als...) Als u het eigen signaalblad hebt 

opgeslagen, kunt u altijd kiezen voor Update Saved Layout (Opgeslagen layout updaten) als 

aanvullende wijzigingen worden doorgevoerd. Zie voor verdere informatie over signaalbladen het 

hoofdstuk Signaalbladen. 
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Signaalbladen 

Een signaalblad toont een of meer signalen in een tabvenster in de werkruimte. Noxturnal wordt 

geleverd met voorafgedefinieerde signaalbladen, zoals de bladen Respiratory (Ademhaling), PSG 

(PSG) en Pulse Oximeter (Pulsoximeter). 

Om signalen aan een signaalblad toe te voegen of eruit te verwijderen, navigeert u de muis naar het 

taakvenster Signals and Data (Signalen en gegevens) rechts van de werkruimte. Als de muiscursor 

boven deze tab staat, komt het taakvenster Signals and Data (Signalen en gegevens) naar voren. Een 

lijst van alle beschikbare signalen wordt in dit taakvenster weergegeven. Een aanvinkvakje naast het 

signaal bepaalt of het signaal al dan niet in het blad wordt weergegeven. Vink het vakje aan of haal 

het vinkje weg om het signaal aan het blad toe te voegen of eruit te verwijderen. Zie hieronder de tab 

Signals and Data (Signalen en gegevens). 
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Werken met signalen 

 

De navigatiebalk maakt snelle navigatie mogelijk naar elk moment in de registratie. De blauwe 

lijn geeft aan waar in de registratie de gebruiker zich bevindt. Klik op elke plaats in de balk om 

naar dat moment te gaan. 

De tijd-as geeft de registratietijd en de tijdperiode weer in het venster. Klik met de 

rechtermuisknop op de tijd-as om het interval in het venster te wijzigen. Rek de tijd-as uit of 

maak deze smaller met de muis om het tijdinterval in het venster te wijzigen. 

De synchronisatiemarker op de tijd-as wordt gebruikt voor het synchroniseren met andere 

signaalbladen en aanzichten. De klok aan de rechterzijde van de navigatiebalk toont de tijd van 

de markerpositie. De synchronisatiemarker kan in de tijd worden gesleept en verplaatst. 
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De signaalwaarde-as toont de naam van het bijbehorende geplotte signaal en de waarde-

asschaal. De as kan met de muis worden uitgerekt/smaller gemaakt. Om de eigenschappen van 

de waarde-as te wijzigen, dubbelklikt u op de as. Er wordt dan een dialoog weergegeven 

waarmee de eigenschappen kunnen worden gewijzigd. 

Signaalplot in een deelvenster. Signalen kunnen op een groot aantal manieren worden ingesteld. 

Verander de grootte van het signaaldeelvenster of verplaats het signaaldeelvenster door de muis 

te gebruiken. Om de eigenschappen van het signaal te wijzigen, dubbelklikt u op het signaal. Er 

wordt dan een dialoog weergegeven waarin de signaaleigenschappen kunnen worden gewijzigd. 

Voor toegang tot alle acties voor een individueel signaalspoor klikt u met de rechtermuisknop op 

het signaalspoor en komt het volgende menu beschikbaar. 

 

Toetsenbordnavigatie: 

Navigeer en manipuleer het signaalblad door de volgende shortcuttoetsen in te drukken: 
 
Navigatie: 

 Rechtertoets = standaard - halve pagina vooruitspringen, configureerbaar door de gebruiker 

 Linkertoets = standaard - halve pagina terugspringen, configureerbaar door de gebruiker 

 Ctrl + rechtertoets = standaard - hele pagina vooruitspringen, configureerbaar door de 

gebruiker 

 Ctrl + linkertoets = standaard - hele pagina terugspringen, configureerbaar door de gebruiker 

 PageDown-toets = pagina vooruitspringen 

 PageUp-toets = pagina terugspringen 

 Home-toets = Start van de registratie 

 End-toets = Einde van de registratie 

 Shift + rechtertoets = Verhoogt de aangegeven tijd in het venster 

 Shift + linkertoets = Verlaagt de aangegeven tijd in het venster 

 Shift + Ctrl + linkertoets = Spring naar de vorige datasessie 

 Shift + Ctrl + rechtertoets = Spring naar de volgende datasessie 
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 - toets = Uitzoomen uit de selectie 

 + toets = Inzoomen in de selectie 

 Muiswieltje = Vooruit-/achteruitbladeren 

 Muiswieltje + Ctrl-toets = Omhoog- en omlaagbladeren 

Actief signaal: 

 Shift + Up = Signaalschaling verhogen 

 Shift + Down = Signaalschaling verlagen 

 Ctrl + Up = Signaal omhoogschuiven 

 Ctrl + Down = Signaal omlaagschuiven 

 Shift + Return = Toon actief signaal in nieuw blad 

 Shift + Delete = Verwijder actief signaal uit blad 

 Up-toets = Selecteer bovenstaand signaal 

 Down-toets = Selecteer onderstaand signaal 

 Ctrl + F = Voorvallen zoeken 

 F9 = Signaal automatisch schalen 

Signaalblad: 

 Spatie = Afspelen/Pauzeren registratie terugspelen 

 Ctrl + W = Signalen automatisch schalen 

 Ctrl + A = Signalen schikken 

Voorvallen: 

 Tab = Volgende voorval, indien u naar het volgende zoekresultaat zoekt 

 Shift + Tab = Vorige voorval, indien u naar het vorige zoekresultaat zoekt 

 Delete = Geselecteerde voorvallen verwijderen of voorvallen verwijderen die de selectie 

overlappen 

 Return = Deselecteren van alle voorvallen 

 Esc = Verwijderen van alle selecties 

Werken met voorvallen 

Voorvallen worden gebruikt voor het identificeren van gebieden van interesse in een signaal. Een 

voorval heeft een start- en een stoptijd en een type dat wordt gebruikt om het te classificeren. 

Voorvallen kunnen handmatig worden toegevoegd aan een signaal of gescoord door de automatische 

analyse om gebieden van interesse te vlaggen. Voorvallen kunnen worden veranderd of verwijderd. 

Scoren van een voorval 

Om een voorval te scoren, gaat u naar een blad dat signalen bevat; lokaliseer een gebied op een 

signaal van interesse. 

 Markeer met de linkermuisknop een gebied om het voorval op te scoren. 
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 Druk op de shortcuttoets voor dat voorval. Ga voor een lijst met shortcuttoetsen naar Edit > 

Configuration > Scoring Shortcut Keys… (Bewerken > Configuratie > Scoren shortcuttoetsen…vanaf 

de Noxturnal taakbalk. 

 

Een andere methode voor het scoren van een voorval is het markeren van een gebied met de 

linkermuisknop, zoals eerder, maar dan klikt u met de rechtermuisknop op het gebied en selecteert u 

een voorval uit de lijst. 

Scoren met een enkele klik 

Noxturnal voorziet in de optie van het gebruik van Single Click Scoring (Scoren met één enkele klik). 

Om         scoren met één enkele klik te activeren, klikt u op het pictogram in de Noxturnal taakbalk.  

 

Binnen het toepasselijke signaalblad scoort u handmatig een voorval op het relevante signaalspoor. 

Zie voor instructies over handmatig scoren van een voorval het bovenstaande hoofdstuk Scoren van 

een voorval. Als u het eerste voorval hebt gescoord, kunt u met de functie scoren met één enkele klik 

doorgaan met het scoren van hetzelfde voorvaltype met slechts een enkele muisklik als u door de 

registratie bladert. 

 

Verwijderen van een voorval 

Er zijn verscheidene manieren om bestaande voorvallen te verwijderen: 

 Selecteer een voorval door er met de linkermuisknop op te klikken en druk dan op de toets 

Delete (Verwijderen). 

 Klik met de rechtermuisknop op een voorval en selecteer Remove Event (Voorval 

verwijderen). 
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 Selecteer een gebied met de muis dat kruist met de voorvallen om dit te verwijderen en druk 

op de toets Delete (Verwijderen). 

Verplaatsen van een voorval 

Om een voorval te verplaatsen, selecteert u het voorval door de linkermuisknop ingedrukt te houden 

en het voorval dan naar de gewenste plaats te slepen. Voorvallen kunnen tussen signalen worden 

gesleept en naar een andere tijdsperiode. 

Veranderen van de grootte van een voorval  

Om de grootte van een voorval te veranderen, verplaatst u de muiscursor over de linker- of 

rechterbegrenzing van een voorval. De muiscursor moet veranderen in een pictogram van een pijl die 

naar rechts en links wijst. Zodra het pictogram in een pijl is veranderd, klikt u met de linkermuisknop 

en sleept u het voorval naar de gewenste duur. 

Navigeren van voorvallen 

Er zijn verscheidene manieren om door gescoorde voorvallen te navigeren in de registratie: 

 Spring tussen de voorvallen die zijn gescoord op een signaal door op het signaal te klikken en 

de Tab-toets in te drukken die springt naar het volgende voorval in de tijd. Om te springen 

naar het vorige voorval in de tijd drukt u op de Shift + Tab-toets. 

 In de rechterbovenhoek van de werkruimte ziet u een zoektekstvak dat u kunt gebruiken om 

te zoeken naar voorvallen die zijn gescoord. Klikken op het tekstvak toont een 

vervolgkeuzelijst van alle voorvaltypen die zijn gescoord. Om te zoeken naar voorvallen van 

een bepaald type klikt u op het voorvaltype in de lijst. Dit toont het volgende voorval in de 

tijd met dat type. Klik op de navigatieknoppen in de vervolgkeuzelijst om door de voorvallen 

te navigeren. 

 Selecteer View > Event Overview (Bekijken > Voorvaloverzicht) uit de Noxturnal taakbalk 

om een overzichtvenster weer te geven dat alle voorvallen die in de registratie zijn gescoord 

toont in een plot. Om naar een specifiek voorval te navigeren, klikt u erop in het 

overzichtsplot. 
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Analyseprotocols 

Een Analyseprotocol is een groep detectors die op de registratie kunnen worden uitgevoerd om 
verscheidene voorvallen te detecteren en te markeren binnen de geregistreerde signalen. De 
beschikbare analyseprotocols, inclusief de standaardprotocols, worden genoemd onder het menu 
Analysis (Analyse). Om een analyseprotocol uit te voeren op de registratie selecteert u de 
toepasselijke analyse uit het menu Analysis (Analyse) en klikt u erop. 

Noxturnal voorziet in een reeks standaard analyseprotocols en u kunt ook een nieuw analyseprotocol 

aanmaken dat gebruikt maakt van instellingen en/of -detectors op maat. Om een analyseprotocol op 

maat te installeren, gaat u naar Analysis > Manage Protocols (Analyse > Protocols beheren) uit de 

Noxturnal taakbalk. U kunt een bestaand protocol Edit (Bewerken) en Rename (Hernoemen) of een 

New based on (Nieuw op basis van) een bestaand protocol aanmaken. 

  

Voor dit voorbeeld zullen we een nieuw analyseprotocol aanmaken. Selecteer New (Nieuw) in de 

dialoog Manage Analysis (Analyse beheren). Een nieuw Analysis Protocol (Analyseprotocol)-blad 

opent, waarin het nieuwe protocol kan worden gedefinieerd. Een protocol is een verzameling 

detectors en de functie van een detector is het lokaliseren van gebieden van belang binnen een 

signaal en scoren van de gebieden met voorvallen.   

Om een detector aan het protocol toe te voegen, kiest u de detector uit de lijst van Detectors 

(Detectors) en selecteert u Add Detector>> (Detector Toevoegen>>). General Properties (Algemene 

Eigenschappen) en het Input Signal (Inputsignaal) kunnen worden bewerkt.  
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Als u uw analyseprotocol installeert, klikt u op Save and Close (Opslaan en Afsluiten) en wordt het 
protocol toegevoegd aan de lijst van beschikbare analyses.  

Werken met scoretoekenningen 

Een scoretoekenning is een verzameling voorvallen die worden gescoord op signalen in de registratie. 

De acties voor het werken met scoretoekenningen vindt u in de Scoring Button 

(Scoretoekenningsknop) in de Noxturnal taakbalk. De acties voor het werken met scoretoekenningen 

worden genoemd in de onderstaande hoofdstukken.  

 

Als u een Analysis protocol (Analyseprotocol) hebt opgenomen in het Recording Type 

(Registratietype) dat is geconfigureerd voor de registratie, dan gebruikt Noxturnal bij het downloaden 

uit een Nox registratieapparaat automatisch het standaard analyseprotocol voor het analyseren van 

de registratie. Voor onlineonderzoeken moet u de registratie afsluiten als deze is voltooid en indien 

geopend vanuit de registratiebibliotheek analyseert de gedefinieerde standaardanalyse de gegevens. 

Het automatisch analyseren van de gegevens genereert een nieuwe scoretoekenning met de naam 
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Untitled Scoring (Ongetitelde scoretoekenning), zie bovenstaande schermafbeelding. In de Scoring 

Button (Scoretoekenningsknop) ziet u altijd de  Selected Scoring (Geselecteerde scoretoekenning) 

die wordt gebruikt voor het rapporteren en registreren van overzichtsfuncties. U kunt gemakkelijk 

nieuwe scores toekennen door gebruik te maken van de functies van de Scoring Button 

(Scoretoekenningsknop), bijvoorbeeld als u wijzigingen doorvoert in de automatische 

scoretoekenning kunt u die gemakkelijk opslaan als nieuwe scoretoekenning, met de van toepassing 

zijnde naam. 

 

Vanuit de Scoring Button (Scoretoekenningsknop) kunt u ook Add Event Period (Voorvalperiode 

toevoegen) of Add Tech Note (Technische notitie toevoegen) aan de registratie. 

Nieuwe scoretoekenning 

Bij gebruik van apparaten die een EEG registreren, kunt u gebruikmaken van de 

slaapstadiëringsfuncties van Noxturnal. Noxturnal voorziet in een automatische slaapstadiëring bij het 

systeem, maar handmatige slaapstadiëring is ook mogelijk.  

De manier waarop handmatige slaapstadiëring wordt uitgevoerd is dat u gebruikmaakt van de Scoring 

Button (Scoretoekenningsknop) om een New Scoring (Nieuwe scoretoekenning) te selecteren. 
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Daarna kunt u, om de slaapstadiëring te starten, de actie Start Sleep Staging (Slaapstadiëring starten) 

kiezen uit het menu in the Scoring Button (Scoretoekenningsknop). De nummertoetsen op uw 

toetsenbord worden gebruikt voor de standaard slaapstadiëringhotkeys. U kunt de 

scoretoekenningshotkeys veranderen zoals hieronder wordt uitgelegd. 

De Scoring Button (Scoretoekenningsknop) is ook de knop waarmee u uw Bio Calibration 

(Biokalibratie) kunt starten. 

Selecteer een scoretoekenning 

Meerdere scoretoekenningen kunnen in verband worden gebracht met één enkele registratie. Alle 

beschikbare scoretoekenningen worden genoemd in het scoretoekenningspanel. Selecteer de actieve 

scoretoekenning door erop te klikken. 

Sla de scoretoekenning op 

Sla de actieve scoretoekenning op door te klikken op de optie Save Scoring (Scoretoekenning 

opslaan). De gebruiker wordt gevraagd om een naam voor de opgeslagen scoretoekenning. De 

opgeslagen scoretoekenning wordt toegevoegd aan de lijst met scoretoekenningen.  

Scoretoekenning verwijderen 

Als een scoretoekenning actief is, zal deze actie deze verwijderen. Als de actieve scoretoekenning 

lokale wijzigingen heeft, wordt de gebruiker gevraagd of hij zijn lokale wijzigingen wil opslaan. 

Scoretoekenning ongedaan maken 

Als een scoretoekenning lokale, niet-opgeslagen wijzigingen heeft, kunnen deze wijzigingen ongedaan 

worden gemaakt. Dit betekent dat de scoretoekenning zal worden teruggebracht naar de toestand 

waarin deze was toen deze werd geladen. 
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Geselecteerde scoretoekenning verwijderen 

Een opgeslagen scoretoekenning kan worden verwijderd door deze te selecteren uit de 

scoretoekenning en te klikken op de optie Delete Selected Scoring (Geselecteerde scoretoekenning 

verwijderen). Er wordt een prompt weergegeven die vraagt of het OK is om de scoretoekenning te 

verwijderen. 

Scoretoekenning toetsenbordshortcuts  

Een shortcuttoets wordt gebruikt om voorvallen snel te scoren. Voor een lijst van bestaande 

toetsenbord-scoretoekenningshortcuttoetsen of om shortcuttoetsen te wijzigen, gaat u naar Edit > 

Configuration > Scoring Shortcut Keys… (Bewerken > Configuratie > 

Scoretoekenningsshortcuttoetsen…). 

De algemene regel is dat voorvallen alleen één enkel toetsenbordteken als shortcut hebben, maar een 

combinatie van Ctrl, Shift en Alt plus een toetsenbordteken wordt ondersteund. 

Noxturnal rapporten 

Noxturnal voorziet in een reeks standaardrapporten die toegankelijk zijn door te klikken op het menu 

Reports (Rapporten) vanuit de Noxturnal taakbalk. De standaardrapporten beschikbaar in Noxturnal 

zijn afkomstig uit twee verschillende bronnen, sommige zijn opgebouwd in het zogenaamde nieuwe 

rapportsysteem (geïmplementeerd in Noxturnal 4.x) en andere zijn opgebouwd in een ouder 

Noxturnal rapportsysteem en worden Legacyrapporten genoemd. We bevelen gebruikers ten zeerste 

aan om gebruik te maken van het nieuwe krachtige rapportsysteem als u gemakkelijk rapporten wilt 

bewerken en aan uw eigen wensen aanpassen. Zie voor instructies over hoe u rapporten aan uw 

wensen kunt aanpassen in het nieuwe rapportsysteem hieronder het hoofdstuk Rapporten aan uw 

wensen aanpassen. 

Het is belangrijk voor gebruikers om zich ervan bewust te zijn dat er een aantal verschillen zijn in de 

mechanismen tussen het nieuwe Noxturnal rapportsysteem en de legacyrapporten. Hieronder volgt 

uitleg over de verschillen tussen de rapportsystemen; 

 Er is een verschil in de berekening van de positie en de activiteit. De onderstaande tabel 

geeft een overzicht van de verschillende berekeningen voor positie- en activiteitparameters 

binnen de legacyrapporten en het nieuwe rapportsysteem. 

Noxturnal rapporten Berekening van positie en activiteit 

Nieuw rapportsysteem 
Positie en activiteit berekend op basis van slaapperiode 

(PSG) of geschatte slaapperiode (PG) 

Legacyrapporten 
Positie en activiteit berekend op basis van de gehele 

nacht 

In het nieuwe rapportsysteem worden de positie- en de activiteitparameters toegevoegd aan 

de totale slaaptijd (TST), bijv. “Tijd liggend (in TST)”. Binnen de legacyrapporten geeft de 

parameter aan “Tijd liggend”. 
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 Binnen de legacyrapporten wordt de kwaliteitsindex berekend op basis van de periode 

gekozen bij het bestuderen van registraties (selectie beschikbaar in de informatiebalk rechts 

onderin Noxturnal). Als de gekozen periode de “Whole Recording” (“Gehele registratie”) is, 

wordt de kwaliteitsindex niet beïnvloed binnen de rapporten bij verandering van de start- en 

stoptijd van de analyse voor de registratie. Als de gekozen periode “Analysis” (“Analyse”) is, 

wordt de kwaliteitsindex geüpdatet volgens de geselecteerde analyseperiode. Voor het 

nieuwe rapportsysteem is de kwaliteitsindex altijd afhankelijk van de analyseperiode. 

 

 De rapportresultaten zijn vast en worden niet geupdatet als de analyse van de 

registratie verandert. 

 Als veranderingen worden doorgevoerd in de analyse, kan een ander rapport 

worden gegenereerd of kan het bestaande rapport worden ververst. 

Genereren van rapporten 

Als u een rapport hebt gegenereerd in het nieuwe rapportsysteem, kunt u het rapport gemakkelijk 

wijzigen door gebruik te maken van de knop Edit (Bewerken) die zichtbaar is in de taakbalk bij het 

bekijken van rapporten. 

 

De knop Edit (Bewerken) activeert de Edit Mode (Bewerkingsmodus) waarmee u het rapport kunt 

bewerken op dezelfde manier als wanneer u gebruik zou maken van Microsoft Word®. Alle 

wijzigingen die u doorvoert, zijn onmiddellijk voor u zichtbaar. U kunt ook nieuwe indices toevoegen 

en zelfs voorgedefinieerde rapportonderdelen als u een onderzoek interpreteert. Om de modus Edit 

(Bewerken) te stoppen drukt u opnieuw op de knop Edit (Bewerken). Wijzigingen die worden 

doorgevoerd in de modus Edit (Bewerken) worden niet opgeslagen als onderdeel van de 

rapporttemplate.  
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Aan uw wensen aanpassen van rapporten 

Noxturnal voorziet in een krachtig rapport-op-maatsysteem dat op Microsoft Word® lijkende 

mogelijkheden bevat. Rapporten in Noxturnal kunnen gemakkelijk aan uw wensen worden aangepast. 

Voor het aanmaken van een rapport-op-maattemplate volgt u de onderstaande stappen. 

1. Selecteer vanuit de Noxturnal taakbalk Reports > Manage Rapporten… (Rapporten > 

Rapporten beheren…). 

2. In de dialoog Manage Reports (Rapporten beheren) selecteert u één van de opties Edit 

(Bewerken), New (Nieuw) of New Based On (Nieuw op basis van), afhankelijk van uw 

voorkeuren. 

 
 

3. Voor dit voorbeeld maken we een nieuw rapport op maat aan op basis van het standaard 

PSG-rapport [AASM 2013]. Selecteer het PSG-rapport [AASM 2013] uit de lijst van 

beschikbare rapporten en klik op New Based On (Nieuw op basis van). 

4. U ziet de volgende dialoog waarin u het nieuwe rapporttemplate een naam kunt geven en 

dan selecteert u Create (Aanmaken). 

 
5. Een nieuw blad opent met het standaard PSG-rapport [AASM 2013] en in dit venster kunt u 

het rapport bewerken. Aan de rechterkant van het scherm ziet u een verzameling Fields 

(Velden) en Report Parts (Rapportonderdelen) die u voor uw rapport kunt gebruiken. Zie 
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voor verdere informatie over rapportonderdelen en velden het hoofdstuk 

Rapportonderdelen en rapportvelden. 

 
NB: In het rapporttemplate kunt u over de velden (-) bewegen met de muis om de details van 

de parameters te zien. Zie onderstaande afbeelding. 

 

RAPPORTONDERDELEN EN RAPPORTVELDEN 

Elk rapportonderdeel vertegenwoordigt een hoofdstuk van uw rapport, zoals Oximetriesaturatie, 

PLM-details, etc. Rapportonderdelen en -velden kunnen worden aangemaakt in Noxturnal en u kunt 

rapportonderdelen opslaan uit standaardrapporten om beschikbaar te hebben bij het vanaf het begin 

aanmaken van rapporten. 
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AANMAKEN VAN NIEUWE RAPPORTONDERDELEN 

U kunt nieuwe rapportonderdelen aanmaken en opslaan voor later gebruik. Om dat te doen, 

selecteert u het van toepassing zijnde rapportonderdeel in het rapporttemplate (of een naar uw wens 

aangemaakte tekst/tabel) die u sleept en verplaatst naar de lijst van Report Parts 

(Rapportonderdelen). Geef het rapportonderdeel een naam en selecteer de categorie. Het nieuwe 

rapportonderdeel dat u hebt aangemaakt, zal worden toegevoegd aan de lijst van Report Parts 

(Rapportonderdelen). 
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AANMAKEN VAN EEN NIEUW RAPPORTVELD 

U kunt nieuwe rapportvelden aanmaken en opslaan voor later gebruik. Om dat te doen, volgt u de 

onderstaande stappen. 

1. Voor dit voorbeeld zullen we het standaardveld selecteren dat beschikbaar is in 

Noxturnal Desat Drop ≥ 4% Count (Desat.daling ≥ 4% telling) als basis voor ons veld op 

maat. Selecteer de Desat Drop ≥ 4% Count (Desat.daling ≥ 4% telling) en klik op New 

Based On (Nieuw op basis van). 
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2. In de dialoog Edit Report Field (Rapportveld bewerken) geeft u het nieuwe veld een 

naam en bewerkt u de eigenschappen van het nieuwe veld zoals vereist. 

 

Voor dit voorbeeld zullen we de desaturatiedaling veranderen in ≥ 3 en het nieuwe veld een 

beschrijvende naam geven, Desat Drop ≥ 3% Count (Desat.daling ≥ 3% telling). Als de condities zullen 

worden gewijzigd, klikt u op Conditions (Condities) om alle beschikbare condities te zien. 

RAPPORTONDERDELEN EN -VELDEN TOEVOEGEN AAN RAPPORTEN 

Om Report Parts and Fields (Rapportonderdelen en -velden) toe te voegen aan uw rapport, 

verplaatst u de muiscursor naar de voorkeurslocatie in het rapport en dubbelklikt u op het gewenste 

rapportonderdeel uit de lijst aan de rechterkant. Een andere manier om een rapportonderdeel en -

veld aan een rapport toe te voegen, is om het gewenste rapportonderdeel/-veld in uw rapport te 

slepen en in uw rapport te plaatsen. 

KOPTEKST EN VOETTEKST VAN HET RAPPORT 

Om de koptekst en voettekst van het rapport aan uw wensen aan te passen, volgt u de onderstaande 

stappen. 

1. Vanuit de Noxturnal taakbalk selecteert u Tools > Settings > User & Company (Tools > 

Instellingen > Gebruiker en Bedrijf) en u ziet de volgende wizard waar u gebruikers- en 

bedrijfsinformatie kunt invullen.  
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Vul de bovenstaande velden in met  alle van toepassing zijnde informatie. U kunt de informatie 

ingevoerd in uw rapport invoegen met gebruikmaking van de overeenkomstige rapportvelden.  

 

2. Om de informatie in te voegen in de koptekst/voettekst van uw rapport plaats u de 

muiscursor binnen het bovenste gedeelte van het rapport, klikt u met de 

rechtermuisknop en selecteert u de optie Edit Header/Footer (Koptekst/voettekst 

bewerken). 

 

 

3. Voeg de van toepassing zijnde velden uit de lijst met beschikbare velden toe aan het 

koptekstgedeelte. 
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4. Om een logo toe te voegen aan uw rapportkoptekst, klikt u op Format > Insert Image… 

(Format > Afbeelding Invoegen…) zoals hieronder wordt getoond. 

 
 

5. Om een paginanummering toe te voegen aan uw rapport, gaat u naar het eind van de 

rapportpagina en klikt u met de rechtermuisknop en selecteert u Edit Footer (Voettekst 

bewerken). Klik met de rechtermuisknop binnen het voettekstgebied en selecteer Insert 

> Page Number (Invoegen > Paginanummer). 

Als u klaar bent met het installeren van uw rapporttemplate selecteert u Save (Opslaan). Uw rapport 

wordt toegevoegd aan de lijst Report (Rapport) die beschikbaar is vanuit de Noxturnal taakbalk. 

Exporteren van rapporten 

Om een rapport te exporteren, klikt u op Export (Exporteren) vanuit de rapporttaakbalk. 

 

Dit opent een nieuwe dialoog voor het specificeren van het bestandsformaat en de bestandsnaam. 

Klik op de knop Save (Opslaan) als u klaar bent en het rapport wordt opgeslagen op de schijf in het 

gespecificeerde bestandsformaat. 

Afdrukken van rapporten 

Nadat een rapport is gegenereerd, kan de gebruiker het rapport afdrukken. Om een rapport af te 

drukken, selecteert u de optie Print (Afdrukken) uit de rapporttaakbalk. 

 

Een dialoog wordt geopend waarin de afdrukmogelijkheden kunnen worden gewijzigd. Klik op de 

knop Print (Afdrukken) als de instellingen zijn aangepast. 

  



 

   

~ 67 ~ 

De registratiebibliotheek 

De registratiebibliotheek toont en beheert alle registraties die zijn gedownload uit de Nox-

registratieapparaten en de onlineonderzoeken. Als registraties worden geopend of gedownload in 

Noxturnal worden ze automatisch toegevoegd aan de registratiebibliotheek. 

Om een registratie te openen, selecteert u deze uit de registratiebibliotheeklijst en dubbelklikt u. 

Archiveren van registraties 

Registraties in de registratiebibliotheek kunnen worden gearchiveerd naar een andere locatie of naar 
een permanente opslag. Om een registratie te archiveren, selecteert u een of meerdere registraties in 
de bibliotheek en klikt u op de knop Archive Recording… (Registratie Archiveren…) op het 
registratieinformatiepaneel. Er verschijnt een dialoog die de gebruiker door het archveringsproces 
leidt. 
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Regelgevingsinformatie 

Beschrijving van symbolen en afkortingen  

 
 CE-markering die conformiteit aangeeft met de 

Europese richtlijnen 93/42/EEC en 2007/47/EC 
betreffende medische hulpmiddelen 

UDI: 15694311110255 VVvvrr  Unieke hulpmiddelidentificatie (Unique Device 
Identifier, UDI); de eerste 14 letters 
vertegenwoordigen de hulpmiddelidentificatie (DI) 
(“15694311110255”) en de laatste zes 
vertegenwoordigen de softwareversie 

(01)15694311110255(8012)VVvvr

r(11)YYMMDD(10)YYMMDD 

 Unieke hulpmiddelidentificatie (Unique Device 
Identifier, UDI); (01) vertegenwoordigt de 
hulpmiddelidentificatie (DI) (“15694311110255”), 
(8012) de softwareversie, (11) de 
productiedatum/datum van fabricage (“JJMMDD”, met 
“JJ” de laatste twee cijfers van het productiejaar, 
“MM” de productiemaand en “DD” de productiedag) 
en (10) het partijnummer 
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Over 

Deze handleiding wordt in elektronisch formaat verstrekt in overeenstemming met Commission 

Regulation (EU) No 207/2012 van 9 maart 2012 betreffende elektronische instructies voor gebruik van 

medische hulpmiddelen. 

Deze handleiding wordt verstrekt als pdf-document. PDF-readers zijn meestal voor gebruikers 

kosteloos beschikbaar. 

Deze handleiding is ook beschikbaar op de website van Nox Medical: 

http://support.noxmedical.com/hc/en-us/articles/200863875-Noxturnal-Software-Manuals 

Een versie op papier kan zonder extra kosten worden aangevraagd door een e-mail te sturen naar 
support@noxmedical.com. De versie op papier wordt binnen 7 kalenderdagen toegestuurd. 

http://support.noxmedical.com/hc/en-us/articles/200863875-Noxturnal-Software-Manuals

